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ABSTRACT

RC BUILDING TYPOLOGIES AND FAILURE MODES OBSERVED
DURING THE 2019 ALBANIA EARTHQUAKE

Ramabanaj, Bashkim
M.Sc., Department of Civil Engineering

Supervisor: Prof. Dr. Hiseyin Bilgin

Introducing the thesis approach to the reader about the 2019 earthquake in
Albania highlighted the vulnerability of many building typologies, particularly load-
bearing masonry buildings and unreinforced brick, stone buildings, and RC frame
buildings. The damage to masonry and historic buildings also emphasized the
importance of preserving these structures and implementing proper seismic retrofitting
measures. Is also important to note that the 2019 earthquake in Albania resulted in a
significant loss of life and injury. Overall, the 2019 earthquake in Albania serves as a
reminder of the importance of building resilient communities that are prepared to face
the challenges of natural disasters. This paper consists of an information processing
about building typologies, analysing why these buildings failed after the earthquake,
where the main problem and what measures should be taken so that the same
consequences do not repeat themselves. It is based on research works and information
discovered on the ground in the Durres area which was the most affected. The
methodology will continue with the comparison in (the ETABS model) of two RC
Buildings with different periods of time (1970-1980, 1980-1990) to see the difference

in earthquake resistance.

Keywords: Building RC, earthquake, seismic safety, assessment methods, building
typologies, ETABS model, seismic safety assessment, earthquake

resistance



ABSTRAKT

TIPOLOGJITE E NDERTESAVE BETONARME DHE MENYRAT E
SHKATERRIMIT TE TYRE NGA TERMETI I VITIT 2019

Ramabanaj, Bashkim
Master Shkencor, Departamenti i Inxhinierisé sé Ndértimit

Udhéhegési: Prof. Dr. Hiseyin Bilgin

Prezantimi i temes tek lexuesit rreth termetit te vitit 2019 né Shqipéri vuri né pah
cenueshmériné e shumé tipologjive té ndértesave né vend, veganérisht té ndértesave
me muraturé qé mbajné ngarkesé dhe ndértesave té papérforcuara me tulle, guré dhe
struktur betoni. Démtimi i muraturés dhe ndértesave historike theksoi gjithashtu
réndésiné e ruajtjes sé kétyre strukturave dhe zbatimin e masave té duhura té
rikonstruksionit sizmik. Kjo tezé bazohet né punimet kérkimore dhe informacionin e
zbuluar né terren né zonén e Durrésit e cila ishte mé e prekura. Pér arsye té tilla si
mosha e ndétresave , ndérhyrjet e béra nga njerézit dhe kodi i projektimit té kohés,
kéto lloj ndértesash kane rrezikshmeri ndaj térmetet éshté e me prioritet rishikimi dhe
vleresimi i performances sizmike e ketyre ndértesave dhe duhet te zhvillohen tekina
duke pasur pasasysh kete vleresim per té forcuar kéto ndértesa né ményré gé ato t'i
rezistojné démtimeve té mundshme nga térmeti. Ai konsiston né njé pérpunim
informacioni pér tipologjité e ndértesave, duke analizuar pse kéto ndértesa déshtuan
pas térmetit, ku éshté problemi kryesor dhe ¢faré masash duhen marré gé té njéjtat
pasoja té mos pérsériten. Né metodologji jané pérzgjedhur dy ndértesa Betonarme té
cilat do té krahasohen né (modeli ETABS) dhe do té analizohet pse nuk i rezistuan

térmetit.

Fjalét kyce: Ndértesa Betonarme, térmeti, siguria sizmike, metodat e vlerésimit,
tipologjité e ndértesave, modeli Etabs, vlerésimi i sigurisé sizmike, rezistenca ndaj
térmetit, KTP-89; EC-8
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CHAPTER 1

INTRODUCTION

1.1 General information

The 2019 earthquake in Albania, a seismic event that registered a magnitude of
6.4, resulted in significant damage and loss, casting a spotlight on the crucial role of

building resilience in areas prone to such natural disasters.

Particularly, this devastating event underscored the criticality of understanding
the interplay between Reinforced Concrete (RC) building typologies and the ensuing
failure modes that manifested during the earthquake. This thesis endeavours to explore
this nuanced relationship further, examining the extent to which RC building typology
influences failure modes in seismic events. To analyse these phenomena that are in the
buildings affected by the earthquake are selected two buildings that were damaged
during the earthquake in the city of Durres and were then demolished by the decision

of the government and experts.

1.2 Methodology

The methodology - with the comparison with (Etabs model software) of residential
stock of the existing building in different periods of time 1970- 1980 and 1980- 1990.

The type project 82/2 VIP Building versus the type project 88/2 Baron’s
Buildings - with the old design codes KTP-N2-89 [1] , in accordance with the new
code design Eurocode 8 [2]
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The aim of this study is to use the non-linear static approach (Pushover) to
investigate how this type of structure responds to seismic loads in two scenarios

involving six storey buildings from two different typologies.

This analysis we will estimate Deformed shape of the building in two direction

X,Y with load bearing and the Response of Seismic spectrum Load case

These results will be compared with the actual building damages that were seen,

and their primary causes are subsequently addressed.

The percentage of reinforcement required for the indicated section exceeds the
guidelines of design standards (Eurocode-2 and KTP-2-89) by almost 30% although a
reduction in the amount of reinforcement from the first floor to the ground level of
35.5%.

Furthermore, the use of smooth rebar and the weak concrete that was used in the
construction of some of these buildings (the compressive strength that results in 50%

less than permitted) contribute to these failures.
Some pivotal questions guiding this research are:

= How does the typology of RC buildings contribute to the observed failure
modes during the 2019 Albania Earthquake?

= How do existing RC buildings in the region react to the earthquake?

= What can we understand about their behaviour by the response spectrum?

= What should we have in mind to consider a building safe during earthquake?

These questions emerge from the hypothesis that RC building typology is a

determinant characteristic of building performance during seismic events.

13



1.3 The objective and structure

The primary objective of this thesis is to explore the reaction times to RC-framed

structures that were damaged during the 2019 Durres earthquakes.
- In terms of the structure, this thesis is organized as follows:

e Chapter 1.... Introduction with the topic

e Chapter 2 .... Literature review

e Chapter 3 .... Analytical model of RC buildings with ETABS software
e Chapter 4 .... Analyses of the results

e Chapter 5 .... Conclusions

14



CHAPTER 2

LITERATURE REVIEW

2.1 Building Classification

e Single family rural
e Multi-story RC buildings [6]

a) Pre-1990 large-panel prefabricated buildings (were known for their lack of

upkeep and indicators of degradation).

b) Pre-1990 masonry buildings (high buildings - was characterized by strong
motions between wall, with good seismic performance due to the ability
to work together UMR and CM buildings as a whole up a structure under

seismic load

e Historical Buildings

e Modern Buildings

Buildings before 1990s |

Before 1944 1944-1963 1964-1978 1979-1990 Buildings after 1990s ‘ 2000
Kte kTP [ KTP-9 . KTP N2.890
EUROKODI

1952 1963 78
6.7 A 6.9\ se A S4A
T somwer | 1sonien 2209 261m019

Figure 1. The horizontal diagram for the building classification before 1944 since
2000
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2.2

2.2.

Building Categories
1 Buildings constructed before the 1990s

Low rise buildings built before 1944, generally 1 or 2 floors high and based on
traditional techniques This type of construction process uses walls made of stone
or brick that are 38-50 cm thick.
Low-rise structures based on KTP 1952 that were typically 2 or 3 storeys tall (the
walls of these masonry structures were supported by spread footing) were built
between 1944 and 1963. Prefabricated clay and concrete slabs served as the basis
for the floor and roof structures.
Low to midrise buildings, usually 2 to 3 or 5 floors high, were built between 1964
and 1978 based on KTP 1963 unreinforced masonry (the buildings were intended
for seismic zone of intensity 7-8). Although the structure was made of load-bearing
masonry, some RC construction materials, such as LINTELS, were used.)
Mid-rise buildings with RC columns and slabs, 5 or 6 floors high, were constructed
on KTP -9 - 78 between 1979 and 1990. These novel foundation, slab, and RC
frame typologies all make use of modern building materials. To improve the
performance of structures against seismic stress, reinforced concrete technology
initially developed shortly thereafter became the most utilized material.
The joints were improved, anti-seismic RC columns were inserted, and any-
seismic belt was interconnected with anti-seismic RC columns at building corners
and wall intersections. The first high -rise reinforced concrete building was
designed in Tirana with 15 stories.
e In 1979, prefabricated reinforced slabs were used to construct standard
buildings that were suitable for earthquake zones with intensities between
VIl and VIII. In the 1980s, every building was prefabricated, apart from
the foundation, which was constructed as a single monolithic block.
e In 1982, the new constructions could be distinguished from the
prefabricated ones through their slightly smaller spaces, with column spans
from 3.4 and 4.2 meters.

16



e Substandard resources and inefficient methods of construction were used

to create buildings of this quality.

2.2.2 Buildings constructed after the 1990s

KTP-N.2-89 and Eurocode were used to design mid- to high-rise building
designs, which usually consisted of RE frames with masonry infills 6 to 12 stories high
(RC construction was a popular choice during this new age in terms of structural
typologies). When the Eurocodes went into effect in 2000, significant changes were
made to the structural typologies of buildings that have been designated as RC
structures. After 1991, political and economic upheavals had a significant impact on
architecture and urban development; there was no governmental oversight and no

building code, even in ALBANIA, where construction was thriving.

2.2.3 The main structural typologies based on Eurocodes 2000

e Frame system -Beams and columns are joined together and form an RC skeleton.
The reinforced concrete skeleton - Frame is a geometrically constant and statically
stable unity of columns and beams. The effect of lateral and gravity loading is
resisted by the spatial frame. The beams must be able to withstand the vertical

forces from the slab. [7]

e Shear Wall System: This system consists of vertical RC walls that serve as shear
walls and are strengthened on both the vertical and horizontal axes. It is suggested
that you put these walls along the outside of buildings to prevent torsional

moments.

e A dual system composed up of cores, beams, walls, and columns.

17



2.3 Reinforced concrete (RC) frames

In Albania, concrete reinforced (RC) frame buildings incorporating masonry

infill are typical, particularly in urban settings. [5]

These structures are built using RC frames and masonry walls in between the
columns. However, these structures are vulnerable to destruction during earthquakes,
especially if the RC frame and masonry walls are not joined properly or if there are

problems with the foundation.

Numerous of these structures were damaged by the 2019 earthquake, including
foundation issues, soft story and weak story failures, and damage to staircases, walls,

and stone buildings either in-plane and out-of-plane.

INGV ShakeMap : Costa Albanese settentrionale (ALBANIA)
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Figure 2. The earthquake maps

Up until the collapse of the communist administration in 1990, residential and
government buildings were constructed using masonry typologies. Due to the low cost
at the time, they were developed and constructed, and after 1990, RC building
typologies took their place. The building was built using low-strength masonry
materials such burnt clay or silica bricks, blocks, or stone. Today, these buildings are

still in use.
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2.4 Classification of walls based on load bearing in Types of

Masonry Wall

2.4.1 Load Bearing Masonry Wall:

One of the limitations of load-bearing masonry construction is that it is difficult to
modify the layout of the building once the walls have been constructed. As a result,

major changes or renovations to a load-bearing structure are often difficult and costly.

Load-bearing masonry construction is also not well-suited for regions that are
prone to earthquakes, as it does not perform very well in seismic events. In addition,
load-bearing construction is labour and material intensive, which can make it more

expensive than other types of construction methods.

For these reasons, load-bearing masonry construction is less commonly used in

modern building construction.

2.4.2 Non-Load Bearing Masonry Wall:

In modern building construction, most buildings are constructed using a
combination of structural frames and non-load bearing walls. Structural frames are
made of lightweight yet sturdy materials that can support the weight of the building,
and non-load bearing walls are used to divide the interior space of the building.

This type of construction allows for more flexibility in terms of the interior
layout of the building, as non-load bearing walls can be easily moved or removed
without affecting the structural integrity of the building. This can be particularly useful
for commercial or residential buildings where the interior space needs to be adapted to

changing needs over time.

In addition, non-load bearing structures are typically less labour and material
intensive than load-bearing structures, making them more cost-effective to build. They

also perform very well in earthquakes because the structural frames can flex and

19



absorb the energy from the seismic waves without compromising the integrity of the
building. For these reasons, non-load bearing masonry is becoming increasingly

popular in modern construction.

2.4.3 Solid Block Masonry:

Solid concrete blocks are best used for low rise construction where the load-
carrying capacity of the blocks is necessary. They are often used for the construction
of foundations, basement walls, retaining walls, and boundary walls. Their high
compressive strength makes them suitable for areas with high wind or seismic activity.
They are also ideal for projects where fire resistance is important, as they have
excellent fire-resistant properties. However, due to their weight, solid concrete blocks
may not be suitable for high-rise buildings.

244 AACBLOCK-AUTOCLAVED

AAC blocks, also known as autoclaved aerated concrete blocks [4], have several

pros and cons.
Pros:

e AAC blocks are light in weight, making them easier to handle and reducing the
dead load on structures. This also helps optimize reinforcement consumption.

e Installation of services such as electrical and plumbing is easy due to the chiselling
properties of the blocks.

e These blocks have very high dimensional accuracy.

e AAC blocks have superior thermal and acoustic properties compared to other
blocks or brick masonry.

e They require less plaster per square foot compared to other blocks or brick

masonry.

20



Cons:

e The compression strength of AAC blocks is lower than some other options, at 3-4

MPa.

e Improved quality control is required during production to ensure consistent quality,

and they must be handled properly to prevent wear and tear.

e AAC blocks cannot be manufactured on-site, so they must be transported to the

construction site.

e The unit cost of AAC blocks is higher compared to other types of blocks.

2.5 Factors affecting masonry constructions' vulnerability to

earthquakes

Table 1. The factors that influence the seismic vulnerability of masonry buildings

Greater susceptibility

Lower susceptibility

e Materials of poor quality, poor mortar,
and poor internal connections

e Multi leaf masonry with no transverse
connections

e Irregular stones

Regular and robust units

Interlock of units

Good bond

Masonry behaves monolithically though
the whole thickness of the wall

e Out of plan instability

e Resistance of out of plane failures

Lack of efficient connections
e among walls
e between walls
e horizontal walls

Lack of structural redundancy

Wall intersections with good interlocking

e Presence of ring beams and of tie rods in
each floor and roof

o Efficient floor to wall connection which
reduce stress concentrations.

e Floors do not provide diaphragm actions

e Higher structural redundancy
¢ Internal force redistribution

from sufficiently stiff and resistant

21
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diaphragm

e Irregularly and widely spaced walls
e Excessive unsupported floor spans

Regularly spaced shear walls in at least two
orthogonal directions
Limited floor spans

e Horizontal thrusts — equilibrated only by
out of plane resistance of structural walls

Horizontal thrusts are reacted by in plane
action of strong walls - self equilibrating
systems - by suitable structural elements
- ties floor diaphragms

e High structural and non-structural masses
and low material strength

Masses and weight — in low ratio
stress/strength

In plan

e Torsional effects and stress

concentrations for structural irregularity.

Regular structure -from Upper structure to
foundation

Sufficient torsional resistance ,
Regular path of forces

2.6 Unreinforced brick buildings and their damage

The damage of this structural building during the aftershock took for a few

weeks until the major shock, registering Mw=6.4, with an epicentre about 15.6 km

southwest of Mamurras, was recorded on November 26. [8]

This structure had showed a poor seismic response despite no causalities but

was caused by flaws that result from bad seismic design, abnormalities brought on by

unapproved interventions, inadequate reinforcing detailing, poor material quality, and

subpar construction quality.
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Figure 3. Unreinforced brick building with damage

The Openings placed too close to a building corner decreased the restraining
effect of crossing walls. Openings for doors and windows weaken the bond among
crossing walls. Due to the return walls' inadequate connectivity, the front facade and

return walls often separate after failure.
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(a) Rocking failure (b) Diagonal cracking (C) Bed-joint sliding

Figure 4. The wall failed out of plan due to (a) rocking failure (b) diagonal cracking

(c) bed-joint sliding

Masonry units sometimes not properly overlapped to create an earthquake-

resistant interconnection at the corner points of the constructions.

At the start of the earthquake, this causes walls to separate. Due to poor
resistant conditions, the wall failed out of the plane.
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Figure 5. The behaviour of unreinforced brick masonry infill masonry under
earthquake loading

2.7 Masonry religions and historic building (churches, mosques,

bridges)

The 26th of November 2019 earthquake's seismic impact had involved several

heritages building in Durres, Kruje, Preze.

a. Durrés Castle - Tower 'C' and fortification walls.
b. Gate walls at Porto Romano; Durrés
c. Hammam in the school yard 'September 16' Durres
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We had observed several damage and partial collapse of the castles, in addition to
in the components that follow, the susceptibility of their structural elements and the

reasons for their pre-earthquake structural conditions.

Figure 6. Durrés Castle-Tower 'C' and fortification walls (a)before earthquake , (b)

collapse wall , (c) the structure of steel reinforced

Clay brick walls adorned by multiple leaves and external leaf collapses are evident.
The Durres Castle and some collapsed sections are still visible., the structure of steel

reinforced.

e Gate walls at Porto Romano.

e Toilet (Hammam) in the school yard 'September 16'

Figure 7. Gate walls at Porto Romano; (a) the wall before earthquake , (b) the gate
wall damaged (c) the wall under reconstruction
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Figure 9. The damage of the inside masonry walls of the heritage building of

Hammam in Durres

The conservation status of historical structures was altered by the presence of
inadequate structural retrofitting regulations which - coupled with the presence of pre-
existing damage - altered the reported failures and severe damage. The risk to their
legacy is elevated by the significant earthquake vulnerability that has been observed.
As a result, Albania's extensive built legacy and rich history must be maintained to

safeguard social and historic values and further the nation's economic development.
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The earthquake influenced both mid- and high-rise RC structures, generating
structural and/or non-structural degradation and, in some cases, even collapse. The
study also offers the findings of a statistical analysis of damaged RC buildings in the
Durres municipality in in addition to observations pertaining to physical damage to
RC structures. In the study, the topic is centred on damage patterns and failure
mechanisms that are pertinent to the seismic response of RC structures. After the
earthquakes, masonry infill walls were the most often observed damage pattern. These
walls suffered damage and failure in some cases, and because of the interaction
between the infill and the frame, they had a bearing on the performance of nearby RC
columns. Although RC shear walls were missing from the damaged buildings of this
type, they were predicted to be present in taller RC framed buildings (10 storeys and
higher). In some instances, masonry infill walls were used in place of RC shear walls.
Based on post-earthquake field observations and an accurate seismic assessment of
two earthquake-damaged buildings, a case study has been presented that emphasizes
the seismic behaviours of mid-rise and high-rise cast-in-place RC buildings in the
November 2019 earthquake. Considering the observed performance of RC buildings,

pertinent lessons and recommendations are offered in the last section..

2.8 The comparison between Eurocode and Albanian low for

construction

During the periods of 1970-1980 and 1980-1990, the Eurocode standards were
not applicable as they were still under development and not yet widely adopted.
Instead, the construction rules and standards used in the Balkan countries during that
time were influenced by the political and economic systems in place, particularly

communism.

Under communist rule, the construction industry in the Balkan countries
operated under centralized planning and state control. The state had a significant role
in the design, construction, and approval processes of buildings and infrastructure
projects. The focus was often on fulfilling the needs of the state and promoting
ideological goals rather than following internationally recognized standards.
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The construction practices during that period varied across the Balkan countries,

but some common features can be identified. These include:

e Standardization: The construction industry operated based on standardized designs
and construction techniques. These standardized approaches aimed to streamline
the construction process and ensure efficiency in the use of resources.

e Socialist Realism: Architecture and urban planning often followed the principles
of socialist realism, which emphasized monumentalism, grandeur, and a
representation of socialist ideals. Large-scale public buildings and housing
complexes were commonly constructed with an emphasis on functionalism rather
than aesthetic diversity.

e Prefabrication: Prefabrication techniques were commonly employed in
construction projects. Buildings were often constructed using precast concrete
elements manufactured in factories and assembled on-site. This approach allowed
for faster construction and mass production of standardized building components.

e State Control: The state had a dominant role in the construction industry,
controlling the allocation of resources, labour, and materials. The planning and
approval processes were typically centralized and governed by state authorities.

It is important to note that the specific construction practices and standards varied
among the Balkan countries, as each country had its own unique political and

economic circumstances during that period.

During the 2019 earthquake, the performance of buildings that implemented
Eurocode (a set of European standards for the design of structures) varied depending
on several factors. It is crucial to remember that the specific performance of buildings
during an earthquake depends on a number of factors, including the earthquake's size
and intensity, the design and construction practices implemented, the soil conditions,

and other local factors.

Eurocode is a set of design standards that aims to ensure the structural integrity
and safety of buildings. It provides guidelines for designing structures to withstand
various loads, including seismic forces. Eurocode incorporates advanced engineering
principles and knowledge gained from past earthquakes to improve the seismic

resilience of buildings.
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Some reasons why buildings designed using Eurocode may have performed better

during the 2019 earthquake are:

Seismic Design Considerations: Eurocode includes provisions for seismic design,
considering the specific characteristics of seismic activity in different regions. It
incorporates factors such as ground motion, soil conditions, and expected seismic
forces into the design process. By considering these aspects, buildings designed
according to Eurocode are better equipped to withstand seismic forces.

Enhanced Structural Analysis: Eurocode emphasizes the use of advanced structural
analysis techniques to assess the behaviour of buildings during earthquakes. These
techniques allow engineers to model and predict the response of the structure under
seismic loads more accurately. By conducting a comprehensive structural analysis,
potential weaknesses can be identified and addressed in the design phase, leading
to more robust buildings.

Ductility and Redundancy: Eurocode encourages the use of ductile materials and
the incorporation of redundancy in the structural design. Ductility refers to a
structure's ability to undergo significant deformation without losing its overall
strength and stability. Redundancy means that buildings have multiple load paths
and backup systems, ensuring that the structure remains intact even if one
component fails. These design principles enhance the resilience of buildings during
seismic events.

Quality Control and Construction Standards: Eurocode also emphasizes quality
control and construction practices. It provides guidelines for the proper
implementation of design specifications, including material selection, construction
techniques, and inspection procedures. Adhering to these standards ensures that
buildings are constructed to the required specifications, improving their overall
performance during earthquakes.

While buildings designed according to Eurocode may exhibit improved seismic

performance, you should note that how structures fare during an earthquake can still

vary depending on the specific design, construction quality, and other site-specific

factors. Local regulations and guidelines may also influence seismic design and

performance requirements.
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Prominent researchers have conducted studies and investigations on seismicity in
the Balkan areas, including Albania, to understand the characteristics of earthquakes,
assess hazard levels, and improve seismic risk mitigation. Some key topics of interest
in these studies include:

e Seismic Hazard Assessment: Researchers analyse historical earthquake records
and geological data to assess the seismic hazard in the region. This involves
determining the frequency, magnitude, and location of past earthquakes and
using this information to estimate the likelihood and intensity of

e Future seismic events: Hazard maps are created to identify areas with higher

seismic risk.

2.9 Response of RC structures to the November 26, 2019, Mw 6.4

earthquake in Albania:

Prefabricated RC technology was widely employed in Albania between 1960
and 1990 to create homes and public structures, but since communism fell in the early
1990s, cast in-situ RC construction has taken its place. Besides the change in
construction technology (prefabricated vs cast in-situ), there was also a change in
structural system. Prefabricated RC buildings were mostly in the form of large panel
wall structures, while cast in-situ buildings have moment frame structural system in
which frame members resist the effects of both gravity and seismic loading. Masonry
infills in these buildings are used to enclose interior spaces and act as facade elements
at the exterior. In case of taller buildings structural RC walls are provided to resist
seismic effects jointly with a RC frame (dual system Around 40% of the country's total
building stock was constructed after 1990, and all structures, from low-rise single-
family homes to multi-story residential and office buildings, were created using cast
in-situ RC technology. According to an examination of the buildings affected by the
earthquake that occurred on November 26, 2019, it was discovered that all collapsed
and/or seriously damaged RC structures were constructed after 1990 and used an RC

frame structural system. Field applications of this construction system started on a
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larger scale after 1989, when the Albanian seismic design code KTP-N.2-89 was
released (Science Academy, 1989). Floor system is usually in the form of RC waffle
slabs in which hollow clay blocks or lightweight Styrofoam are used as filling, thereby
creating a system of shallow RC beams in the interior and in some cases deeper edge
beams at the exterior. These shallow beams have a width that is higher than or equal
to the cross-sectional dimension of a column and a depth that is equivalent to the

overall slab thickness (30 cm thickness was specified by KTP-N.2-89).

Even in the case of taller buildings with ten storeys or more, these buildings
were typically constructed without RC structural walls or with a small number of walls,
so their seismic resistance depends on a 3-D moment frame system, which may be
significantly flexible in the case of taller buildings. Most RC buildings in Durres were
unaffected by the September 2019 earthquake (Mw 5.6), despite a number of design
and construction flaws (such as the absence of RC structural walls, strong columns,
and weak beams). However, some of these buildings sustained significant damage
during the more intense November 2019 earthquake (Mw 6.4). It is believed that the
main cause of damage in RC buildings in the November 2019 earthquake was high

seismic demand.

Based to the microzoning map, the Durres geographical area has a seismic
intensity of X, therefore the seismicity coefficient is 0.42g, which corresponds to land
category Ill. The following figure displays elastic spectra in accordance with EC-8
[10] and KTP-2-89 (Albanian Technical Design Code, published in 1989), as well as
actual spectra in accordance with the two main directions of E-W and N-S recorded
by Institute of Geosciences, Energy, Water, and Environment (IGJEUM) at the Durr's

station.
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Figure 10. Peak ground acceleration map in (g%)
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KTP-2 (Cat.lll, ao = 0.42g), EC-8 (Cat.D, PGA 0.27g), and oscillation spectra
collected for both directions at Durr's station. [9]

For example, peak ground acceleration (PGA) recorded in Durrés was 0.2 g,
while spectral accelerations (0.5 g) were about equal to the elastic spectral
accelerations outlined in KTP-N.2-89 for buildings with period ranges that fall within
the range of mid- to high-rise RC frame systems. The basic periods of taller RC
structures were predicted to be in the range of 1.0 sec. Case studies that show how RC
buildings responded to the earthquake in November 2019 have been examined

elsewhere. [10]

Masonry infills significantly affected how well Albanian RC frame
constructions performed during the earthquake because of their flexibility. Buildings
in Albania built after 1990 are frequently built using modular blocks with holes that
are horizontally aligned, which lowers the compressive strength of the masonry.. Also,
due to mixed use of some buildings, there is frequently an "open™ ground floor and
first floor which are used for commercial purposes, while masonry infills exist only at

higher floor levels which are usually intended for residential purposes.

Masonry infills have frequently been constructed in an arbitrary manner, which
could have torsional consequences that increase seismic demand. It is important to
emphasize that the impact of masonry infills on the seismic performance of these
structures depends on the relative ratio of the lateral stiffnesses of the RC frame
structure and the masonry infills, as well as the capacity of the infills under
compression and shear. As a result, RC buildings of various heights showed various
damage patterns. Masonry infills were found to significantly alter the behaviour of
structures in low- and mid-rise buildings, resulting in considerable overall damage or
collapse. Most RC structures that were harmed by the earthquake were constructed
between 1990 and 2010.

More recently built, taller RC frame buildings (10 storeys and up) had a
stronger structural capability of the frame system, but these buildings also experienced

significant damage to the masonry infill due to large interstorey drifts.
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In the earthquake-affected region, irregularities in RC buildings were mostly
caused by the interaction of flexible RC frames with hard masonry infills or stairs. The
most frequent anomalies were "soft storey", "short column", and an uneven stiffness
distribution in plan that had adverse torsional consequences. Examples of buildings

that collapsed because of the "soft storey".

In the present case, buildings with open spaces on the ground floor (garages,
stores, restaurants, etc.) and masonry infills on the upper floors that were used for
residential purposes were what gave the illusion of a "soft storey" (vertical

irregularities).

The seismic demand in the RC columns at the ground floor level was
significantly raised because of the masonry infills and the increased stiffness at the

upper floors, which led to damage and collapse of these structures.

Figure 11. Collapsed buildings in Durrés, Albania due to the “soft storey”

irregularity (McKenney, 2019)

Those two figures illustrate significant damage of an RC frame structure due
to torsional effects caused by masonry infills and a staircase, which were likely
neglected in seismic design. The building has an open ground floor and additional five
floors (Figure 11-a).

The building has a regular column grid; however, it was noticed that columns
in the exterior frames in longitudinal direction were aligned such that the column’s
smaller cross-sectional dimension is aligned in longitudinal direction, which results in
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lower stiffness of these exterior frames compared to interior frames with a different

column alignment.

An eccentric position of the staircase, with regards to the building’s centre of
mass, caused eccentricity of the centre of stiffness in relation to the centre of mass and

the corresponding torsional effects.

High torsional demand contributed to excessive damage of an exterior masonry
infill adjacent to the staircase, as seen in Figure 11-b. Seismic vulnerability of the
staircase was compounded by the “short column” effect at the abutment of the

staircase.

Figure 12. Damage to RC building in Durrés, Albania due to torsional effects: a) a
view of the building after the earthquake; b) damaged masonry infill at the ground

floor level (adjacent to the staircase) and ¢) damaged staircase area
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Figure 13. Damage of RC buildings due to the "short column” effect in the
November 2019 Albania earthquake: a) impact of the stair support on supporting
columns and b) impact of partial masonry infill due to the openings
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Figure 14. Severe damage and failure of masonry infills in RC frame buildings in

Durrés, Albania due to the November 2019 earthquake

2.10 Performance of RC buildings during the November earthquake

Performance of RC buildings during the November earthquake (Mw 6.4)
Masonry buildings account for approximately 25% of the urban building stock in
Croatia, while the remaining 75% are RC structures (moment frames or shear wall

systems). [11]

However, 76% of dwellings in rural areas are masonry buildings, while only
12% are RC buildings (Hadzima-Nyarko et al., 2020). Since the epicentre of the
December 2020 Croatia earthquake was close to Petrinja, a small town (population of
approximately 20,000) surrounded by villages, majority of buildings affected by the
earthquake were loadbearing masonry structures. However, a few RC structures were
also damaged during the earthquake, and relevant observations related to those
buildings are presented next.

The Faculty of Education in Petrinja was built in 1962, and it was constructed

before the first seismic design code in former Yugoslavia was issued in 1964 (PTP,
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1964), hence the building was not designed and detailed for seismic effects. The
building has a RC moment frame system with masonry infill walls. The building has
a T-shaped plan and consists of two rectangular-shaped wings. There is a single-storey
wing and an educational wing which is 3-storey high. The building did not experience
visible damage at the exterior, however widespread damage occurred in the interior
infill walls. Interior damage could be attributed to torsional effects and/or irregularity
in elevation due to different height of building wings. Several walls experienced minor
damage characterized by the spalling of plaster, which caused damage to building
contents. It is expected that the RC frame structure was designed only for gravity loads
and was excessively flexible for the effect of in-plane seismic loads, hence diagonal
cracks developed in masonry infills due to excessive lateral drifts. In some cases,
cracks were observed at the interface between the masonry infill walls and adjacent
RC frame.

The Centre is a RC frame structure with masonry infill walls with RC frames
constructed only in one direction — there is no lateral load-resisting system in the other
direction. Note that the frames were constructed at variable spacing, thereby causing
an eccentricity between the centre of stiffness and centre of mass. The absence of
lateral load-resisting system in one direction, combined with eccentric frame layout in
other direction, caused significant torsional effects and heavy damage of RC columns.
Damage of RC columns can also be attributed to the setbacks in the columns along the
height (an architectural feature), which was unfortunately not addressed by adequate
stirrup spacing. Interior columns were robust (cross-sectional dimensions 55x30 cm)
for a two-storey building; however, the reinforcement detailing was inadequate, with

stirrup spacing at 200 mm. [12]

Frame-infill interaction in the exterior frames caused “short column” effect,
and shear cracks in the columns. Majority of the columns experienced either severe
damage or failure, while upper floor moved downwards by approximately 2 cm,
showing a loss of capacity for resisting gravity loads. Beside the damage of structural
elements, majority of masonry infill walls completely failed. These infills either
experienced cracking or separation from the frame (along the infill-frame interface),
and subsequently tilted in out-of-plane. Additionally, the brick masonry fagade and the

glazing at the entrance doors were also damage.
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CHAPTER 3
ANALYTICAL MODEL OF RC BUILDINGS WITH ETABS

3.1 Object description and analysis (VIP Building)

VIP building number 14 on "Dyrrah" boulevard, which was damaged during
the earthquake of November 26, 2019, was evaluated based on the detailed inspection
of the building site, considering modern building codes on seismicity such as EC-6
and EC-8.

From the observations and inspections made in this building, it was observed
that the building suffered major damage on the upper floor and moderate damage on
the ground floors. Also, the area in which the building is located is one of the areas

with high seismicity in our country according to the seismic risk map of Albania.

This structure with reinforced concrete bearing construction has suffered high
and moderate damages for the poor quality of the structure materials and unqualified
workers, the lack of the building code of the time if they have been applied, and the

lack of inadequate repair after the events’ previous seismic damage.

The biggest structural damages are in the eastern part of the building, where
the concrete is broken and some of these iron columns have lost their stability and
solidity. This term is significantly smaller than the design term according to Eurocode
8. considering the status of the structure, the material quality of the construction, and
the bearing capacity of the structural support system, as well as the building codes of
the time, make the structural reinforcement of building in its damaged parts should not
be possible, according to the expertise done.

The examined building has been identified and its current structural capacity
has been analysed. This building suffered not only heavy structural damage but also

high damage to non-structural elements.

The photographs were taken in the field to describe the current condition of the
building. Current performance has been assessed based on on-site inspection and

observation of general building damage, in accordance with modern seismic codes.
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Figure 15. Vip RC frame buildings in Durrés ~ Figure 16. Vip building fagade in Durrés

Figure 17. Vip building — CT demolition Figure 18. Vip building collapse

According to the technical report the project is designed to present horizontal

terrains at a depth of 1.3m from natural ground.
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A ground base resistance of 2kg/cmz2 is anticipated. In terrain with a loading
charge, the piles should be inserted 50cm below the maximum load level. The
foundations should be applied with a concrete grade not less than 200kg/cm2 for

water-resistant soil.

For the construction of the foundations, use concrete grade M-15. For soil with
water retention, use concrete grade M-25. For soil with the presence of water, use a
cement mix ratio of 1:2. In the case of perennial groundwater levels, it is recommended
that the initial settlement of the foundation, as well as part of its trunk, be made with

lightweight concrete M-100.

This height of the foundation construction with lightweight concrete is
determined by the Projection office of the Government Department. - based on hydro-
geological studies. The dimensions of the foundations specified in the project are
suitable for a height of up to 1.5m.

For the height of the floor over 1.5m. from natural soil and for foundation
insertion depth greater than forecast and for [c] different from 2kg/cm2 - the static
foundation calculations should be re-evaluated by Z.U.P. (the projection office of

Government Department.)

For sloped terrain, the foundations should be applied with stairs with a slope
of no greater than 50cm. respecting the minimum ratio #2 as well as the first stage (the
initial settlement) should be at least from the corner of the foundation’s edge -

minimum 1m.

When the height of the foundation together with the plinth is 1.2m, every 0.9m
to 1.2m, concrete rings of M-100 with a thickness of 10cm should be placed. In seismic
zones 7-8, in strong soil with an allowable soil resistance of not less than 2 kg/cm?, the

M-150 concrete ring with a height of 15cm should be used.

For other types of soil, the M-150 reinforced concrete ring should be used, with
a longitudinal reinforcement area of no less than 4.5cm? (6 6 10) for a width of the
plinth up to 60cm, and 6.8cm? (6 6 12) for a width of the plinth greater than 60cm. The
dimensions of the reinforcement are taken from the construction brochure and

specifications from 1976.
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Corners and places where load-bearing external and internal walls are
interrupted with a thickness of 25cm should be reinforced according to the drawing on

the respective sheet.

Figure 19. Damages made in the building by the earthquake

In the plan of the foundation rings, the cushions made of M-150 concrete are
shown, from which the columns' rebars emerge. The columns K-1 are constructed with
M-150 concrete.

These columns are connected to the masonry through the recesses in the
masonry, which are cleaned of debris and moisture before pouring the concrete. Iron

bars (refer to the sketch) are placed for the connection.

The floor is waterproofed with two layers of bitumen + asphalt with a softening

point of 70°C, on top of the clean concrete layer.
The masonry for seismicity level 7 is applied as follows:

e With red bricks, M-75 --- mortar M-25.

e With silicate bricks, M-75 ---- mortar M-50

The support of partition walls on the intermediate floor is specified in A-3 12 of
the brochure, regarding the types of elements for roofing with tiles and construction

mortar, from 1976.
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Architraves above doors and windows are constructed using precast reinforced
concrete beams, whether load-bearing or non-load bearing, according to the brochures
"Load-bearing Precast Architraves" from 1974 and "Non-load-bearing Architraves"
from 1977, but they must be supported by a minimum of 30cm in the masonry (without
grout).
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Figure 20. Construction project details taken by Technical Institution

Non-load-bearing precast architraves with M-200 concrete are also used on the
spaces between walls, measuring 12cm.

The structures of the intermediate floor coverings are designed according to
Album A 79. Prefabricated reinforced concrete floor slabs, approved by the technical-
scientific council of the Ministry of Construction under decision no. 19.4.26-6-1979,
should be used. Details can be obtained from the same brochure. Anti-seismic
measures are taken from the brochure on types of elements for roofing with tiles and

construction mortar from 1976 but using 4012 (as per the norms in seismic areas).

Ramps of stairs and square platforms are designed for the type with two ramps
with panels, following the intermediate floor slabs, while for the type with a single

ramp with panels, the details are as follows.

For the roofing of the staircase cage, a parapet is left for the exit to the terrace

(refer to the corresponding drawings), and the holes thickness is taken from the
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brochure on types of elements for roofing with tiles and construction mortar, series no.

12.1.76.

The floor layers are taken from the brochure on types of elements for roofing

with tiles and construction mortar from 1976 as follows:

Slab floor for the intermediate floor in brochure A-1/2.

Slab floor for the other floors in brochure A-1/7.

Parquet floor in brochure A 1-2/19. The calculation of the reinforced concrete

structures is done using this theory. The thickness of the mortar layer is estimated to

be 2cm.

The parapets of the terraces in seismicity level 7 should be constructed using

solid brick walls measuring 25cm in height up to 1.2m.

Table 2. The table of the structural analyses for both type of buildings

VIP BUILDINGS

BARON’S BUILDINGS

The pile foundations H = 1.6m
dimension 200 x200 cm and 250 x 250 cm

The pile foundations H =3.20m
dimension 100 x100 cm / 160 x 80 cm

Continuous Beam Foundation are only at
the outside of the piles with dimension /
40x40cm/30x40CM

The other Piles are non-connected with the
other structure at the foundation

Continuous Beam Foundation had
connected all the piles of the foundation
with

the dimension 80c80 cm/ 70x80 cm /
40x40cm

The columns are symmetric with
dimension

30 x 40 cm (in total 21 columns)

The columns are with dimension 51x38cm,
38x38,

38x25 cm (in total 14 columns)

Structure plan for the typical floor

¢ LONGITUDINAL BEAMS
ACCORDING TO THE AXIS and
concrete BEAMS AT console

¢ TRANVERSE BEAMS ACCORDING
TO THE AXIS & concrete BEAMS AT
console

Structure plan for the typical floor

e TRANVERSE BEAMS
e LONGITUDINAL BEAMS
ACCORDING TO THE AXIS
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For seismicity level 8, the parapets should be constructed using concrete/steel

columns connected with anti-seismic reinforcement (refer to the respective sketch).

3.2 Object Etabs Modelling (VIP BUILDING)

e Step 1 Begin a New Model

In this Step, the basic grid that will serve as a template for developing the model

will bedefined.

A. Click the File menu > New Model command or the O New Model button.
Theform shown in Fig. 21 will display. Verify that the default units are set to KN,
m, C.

B. The New Model formallows for the quick generation of numerousmodel types
using parametric generation ®res However, in this tutorial the model will be
started using only the grid generation. When laying out the grid, it is important that
the geometry defined accurately represents the major geometrical aspects of the
model, so it is advisable to spend time carefully planning the number and spacing
of the grid lines. Select the Grid Only button, and the form shown in Fig. 21 will
display.

C. The grids and spacing in the X, Y, and Z axes are specified using the Quick Grid Lines

form (Fig. 21). Eight grid lines should be used in the X and Y directions, and seven

grid lines should be used in the Z direction. In the X, Y, and Z directions spacing edit

boxes, enter 8, 6, and 3.1, respectively. For the sake of this tutorial, make sure that all

the values in the First Grid Line Location area are set to zero. This area's values

identify where the grid lines' origin is. To proceed, press the OK button

D. The grids and spacing in the X, Y, and Z axes are specified using the Quick Grid
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Lines form (Fig. 21). Eight grid lines should be used in the X and Y directions, and
seven grid lines should be used in the Z direction. Inthe X, Y, and Z directions spacing
edit boxes, enter 8, 6, and 3.1, respectively. For the sake of this tutorial, make sure
that all the values in the First Grid Line Location area are set to zero. This area's values

identify where the grid lines' origin is. To proceed, press the OK button.

EH New Model x

New Model Intialization Project Information

O Initilize Model from an Existing File
@ hitalize Model from Defauit Settings T e,
Default Units. KN, m, C “
Default Materials United States ~
Save Options as Defaut

Select Template

2D Trusses 3D Trusses

Rat Slab Shells Staircases Storage Structures

Underground Solid Models Pipes and Plates
Concrete

Figure 21. ETABS New Model form
Select Coordinate Systems/Grids from the Define menu. It will show the
Coordinate/Grid Systems form.

Select Global on the Coordinate/Grid Systems form by clicking the Modify/Show
System button. It will then show the Define Grid Data form (Fig. 22).

. The uneven spacing in the X, Y, and Z directions is specified using the Define grid

data type. Set the spacing of the display grid.

For Grid ID 2 in Y Grid Data, set the spacing to two, and for Grid ID 1 in Z Grid
Data, put it to 1.2,

. To close the Define Grid Data form, click the OK button.
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E. Fig. 22 will show up once you click the OK button to close the

Coordinate/Grid Systems form. As seen in Fig. 22, the grids are displayed in

two vertically tiled view windows: an X-Y "Plan" View on the left and a 3-D

View on the right. By choosing the Options menu > Windows command, the

quantity of view windows can be altered.

E Grid System Data
Grid System Name
System Origin

Global X

Global Y

Rotation

Rectangular Grids

X Grd Data

Story Range Option

Top Stary
Story6
Bottom Story

Base

Click to Modify/Shaow:

Reference Points..

Reference Planes...

Options
Bubble Size

Grid Color

Y Grid Data

mm

Giid 1D X Ordinate {m) Bubble Loc ~ ~

0 Yes End

Grid ID Y Ordinate {(m) Wisible Bubble Loc

I 13 Yes Start

2 34 Yes End a o Yes Start
3 6.8 Yes End b 54 Yes Start
4 102 Yes End c 96 Yes Start
5 136 Yes End d 109 Yes Start
6 17 Yes End v
General Grids
Grd ID X1 i{m) Y1 i{m) *2im) Y2 {m) Visible Bubble Loc

Cancel

Figure 22. ETABS Define Grid Data form

In Fig. 22, you will see that the "Plan™ view is open. The title bar of the display
is highlighted when the window is open. By clicking anywhere in the view window,

you can make a view active.

Keep in mind that Z positive is pointing "up” and that the Global Axes are also
visible. When ETABS speaks about gravity's direction, it means "down" or in the

negative Z direction.
e Step 2 Define Material

To create, change, or remove a material property definition, use the Define menu >

Materials command. The structural objects (frame sections, cable sections, tendon
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sections, area sections, solid properties) are then defined using the definitions of the

material properties.

E Define Materials

Materials

CONC

OTHER
C2025
C2530
C3037
3545
C4050
AG15GrED
rebar
rebar_stafa
A416Gr270

Click to:

Modify/Show Material...

Cancel

Figure 23. ETABS Define Materials form

The Define Material form (Fig. 23) will appear when you select the Materials

command from the Define menu.

3 Material Property Data

General Data
Material Name
Material Type
Directional Symmetry Type
Material Display Color

Material Motes

Material Weight and Mass

Weight per Unit Volume

Mass per Uni Volume

Mechanical Property Data
Moduius of Blasticity. E

Poisson’s Ratio, U

Coefficient of Thermal Expansion, A

Shear Modulus, G

Design Propetty Data

C2025
Concrete
Izotropic

Modify/Show Motes

2447.32 kg /m?

2447313 ka/m?
kg /mm?
s
kaf/mm?

Modify/Show Material Property Design Data

Advanced Materal Fropety Data

Nenlinear Material Data.

Material Damping Properics..

Time Dependert Properties

Modulus of Rupture for Cracked Deflections

Figure 25. ETABS Material
Property Data form -Concrete
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E Material Property Data

General Data
Material Name STEEL
Material Type Steel
Directional Symmetry Type Isotropic

Material Display Color

Material Motes

Modify/Show Motes...

Material Weight and Mass

Weight per Unit Volume 7833.41 kgf/m?

Mass per Unit Volume 7333414 kg/m?
Mecharical Property Data

Modulus of Elasticity, E 20389.02 kgf/mm2

Foisson’s Ratio, U 0.3

Coefficiert of Thermal Expansion, A 1/C

Shear Modulus, G kgf/mm?

Design Property Data

Modify/Show Material Property Design Data...

Advanced Material Property Data

Nonlinear Material Data

Material Damping Properties

Figure 24. ETABS Material
Property Data form -Rebar




A 4000Psi should be highlighted in the Materials display list. Next, click the
Modify/Show Material option to bring up the form in Fig. 24.

A Type C20 in the Material Name and Display Colour edit boxes and choose concrete

from the drop-down list under Material Type.
A. Select 25 as the Weight per Unit Volume. Modulus of Elasticity at Set

B. Set Weight per unit Volume as 25. Set Modulus of Elasticity to
4351.1324

C. Set Poisson’s Ratio to 0.2. Set Specified Concrete compression
strength at 29000, then push the OK button.

D. Inthe Materials display list, select an A992fy50. The form shown in Fig. 23
will appear once you click the Modify/Show Material button.

E. Type "Rebar" in the "Material Name" and "Display Colour" edit boxes and

choose "Rebar" from the "Material Type" drop-down list.

F. Set 72.5189, 106.7783, 72.5189, and 108.7783 for the minimum yield
stress, fy, minimum tensile stress, fu, expected yield stress, fye, and
expected tensile stress, fue. To exit all forms, click the buttons on the

Material Property Data form and the Add materials form.
e Step 3 Define Frame Section

When a frame section is defined, it can be assigned to frame objects.

3 Frame Properties *x

Fitter Properties List Click to
Type Al ~

Properties

Find This Property Modify./Show Property

C45x45c30 16620
i 2

Export to XML File

C050.080.30

C055.40.30

€055.055.25

C055.055.30

C055.080.30

C060.35.30

C060.80.30 N

Figure 26. ETABS - Frame properties table
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You can define frame section properties based on a section's dimensions using

the Define menu > Frame Sections command,

e import sections from preconfigured databases, review and amend section
properties,

e and delete section properties.

e Step 4 Establish Load Patterns

Dead, Dead Wall, Dead Slab, Dead FF (Floor Finish), Dead RT (Roof Treatment),
Live, and Live Roof loads operating in the direction of gravity are the loads used in
this problem.

To open the Define Load Patterns form (Fig. 27), select the Define menu > Load
Patterns command. It should be noted that only one default load case—a Dead Load
scenario with self-weight [DEAD]—has been defined.

Keep in mind that the default case's self-weight multiplier is set to 1. This means
that the self-weight of all members will be automatically included in this load pattern
at 1.0 times. Both load patterns and load cases, which may vary, are present in ETABS.
When a load pattern is defined, the program still automatically generates a
corresponding load case, and the load cases are accessible for inspection when the

analysis is run.

E Define Load Patterns X
Loads Click To:
Self Weight Auto
Muttiplier Lateral Load
1
0
0
0 EURQCODE1 2005
0
0 EUROCODES 2004
0 EUROCODES 2004

Cancel

Figure 27. ETABS Define load Patterns form
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Click on the Load Pattern Name column edit box. Enter the new load pattern's

name, DEAD Wall. Choose a load type from the drop-down menu; in this instance,
choose SUPER DEAD. The Self Weight multiplier should be set to 0. To add the Dead
Wall load to the list of loads, click the Add New Load Pattern option.

Add Dead Slab, Dead FF, and Dead RT load cases by repeating item B.

Enter the new load pattern’s name, LIVE. Choose the LIVE load type from the
drop-down menu. The Self Weight Multiplier should be set to 0. To add the Live
load to the load list, click the Add New Load Pattern option.

Enter the new load pattern's name, LIVE ROOF. From the drop-down list, choose
the type of load ROOF LIVE. The Self Weight Multiplier should be set to 0. To
add the Live load to the load list, click the Add New Load Pattern option.

Step 5 Define the Response Spectrum Function

Define Response Spectrum Function. A collection of time versus

spectral-acceleration values is all that makes up a response-spectrum function. Since

the functions themselves are not assumed to have units in ETABS, the acceleration

values in the function are presumed to be normalized. Instead, a scale factor that

multiplies the function and is supplied when the response-spectrum analysis scenario

is constructed is linked to the units.

1.

To view the Define Response Spectrum Function form, select the Define menu >

Functions > Response Spectrum Functions command.

From the drop-down selection in the "Choose the Function Type to Add" section,
select Spectrum from File.

The Response Spectrum Function Definition form will appear when you click the
Add New Function button (Fig. 28).

Enter the function name in the edit box.

In Function Damping Ratio area, type 0.05.
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I3 EuroCode & - 2004 Function Definition

Function Name
Parameters

Country

Direction

Ground Acceleration, ag/g
Spectrum Type

Ground Type

Soil Factor, §

Function Damping Ratio

[ECBC_g=2.76} Damping Ratio 0.05

Function Graph

E-3
320 —

CEN Default

Herizontal

0.248

P

~ 230 —

240 -
200
180
120 -
a0 _
' '

40 4
0.0

~

12

l
10 20 30

Spectrum Period, Th
Spectrum Period, To
Plot Options

(®) Linear X - Linear ¥
() Linear X-Log Y
() Log X - Linear Y
O Log X-Log ¥

Spectrum Peried, Td
Period

Acceleration

Lower Bound Factor, Beta

Behavior Factor, g

Convert to User Defined

oK Cancel

Figure 28. ETABS Define Response Spectrum Functions

e Step 6 Definition of Response Spectrum Load scenario

1. To open the Define Load Cases form, select the Define menu > Load Cases option.

2. The Define Load case data will appear when you click the Add New Load Case
button. (Fig. 29)

3. Enter EQ - X in the Load Case Name Area.

4. From the drop-down box in the Load Case Type Area, choose Response Spectrum.
5. Choose the CQC option in the modal combination area.

6. In the area of applied load

7. To accept the EQ- X analysis case, click OK on the Load Case Data - Response
Spectrum box.

8. On the Define Load Cases form, click the Add New Load Case button.
9. Enter EQ-Y in the Load Case Name Area.

10. Repeat Items D through E.
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11. Applied to Load

12. Load applied region

e From the drop-down box in the Load Type field, choose Accel.

e Choose U2 from the drop-down list in the load name field.

e Choose RS IS 1893 1l (the function defined in step 7) in the function field.

13. Click the Add button

E Load Cases

Load Cases
Load Case Mame Load Case Type

Modal Modal - Fitz

DEAD

LIVE Linear Static

KONST Linear Static

EC8B q=2.76 Response Spectrum

EC8q1 Response Spectrum

spec-y Response Spectrum

Click ta:

Figure 29. ETABS Define Response Spectrum Load case
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Figure 30. ETABS Undeformed shape of the building
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Figure 31. ETABS Deformed shape of the building after analyses

3.3 Object Etabs Modelling (BARON’S BUILDING)
e Step 1 Begin a New Model

In this Step, the basic grid that will serve as a template for developing the model

will bedefined.

A. Click the File menu > New Model command or the O New Model
button. The form shown in Fig. 32 will display. Verify that the default

units are set to KN, m, C.

B. The New Model form allows for the quick generation of numerous model

types using parametric generation techniques.

When you select the Grid Only button, the form in Figure will appear.
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H New Model

New Model Initialization

() Initialize Model from an Existing File
@) Initialize Model from Default Settings
Default Units KN, m, C ~
Default Materials United States ~
Save Options as Defautt

Select Template

M &

Blank Grid Only

2D Trusses

|
|
|
Wall Fat Slab Shells
Underground Solid Models Pipes and Plates

Concrete

Project Information

Medify/Show Information...

3D Trusses

2D Frames

Staircases

Storage Structures

Figure 32. New model form

C. The grids and spacing in the X, Y, and Z directions are specified using
the Quick Grid Lines form (Fig. 33). Eight grid lines should be used in
the X and Y directions, and seven grid lines should be used in the Z
direction. In the X, Y, and Z directions spacing edit boxes, enter 8, 6,
and 3.1, respectively. For the sake of this tutorial, make sure that all the
values in the First Grid Line Location area are set to zero. This area's

values identify where the grid lines' origin is. To go further, press the

OK button..
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A Grid System Data X
Grid System Name: Story Range Option Click to Modfy/Show
Reference Points
) Reference Planes
System Origin Top Story
Global X 0 m Ston6 Options
Global Y 0 m Bottom Story Bubble Sze 1250 om
Rotation a deg Base Grid Color
Rectangular Grids
X Gid Data Y Grid Data
Grid ID X Ordinate (m) Visible Bubble Loc 4 Grid ID ¥ Ordinate m) Visible Bubble Loc
0 Yes End I 13 Yes Start
2 34 Yes End a 0 Yes Start
3 68 Yes End b 54 Yes Start
4 10.2 Yes End c 98 Yes Start
5 136 Yes End d 109 Yes Start
§ 17 Yes End v
General Grids
Gd ID X1 fm) Y1 m) X2 m) Y2 i} Visible Bubble Loc
Cancel

Figure 33. ETABS Define Grid Data form

1. Select Coordinate Systems/Grids from the Define menu. It will show the
Coordinate/Grid Systems form. Ensure that Global is highlighted for the Systems
item on the Coordinate/Grid Systems form will display. The uneven spacing in
the X, Y, and Z directions is specified using the Define grid data form. Set the
spacing of the display grid.

2. For Grid ID 2 in the Y Grid Data, set the spacing to 2, and for Grid ID 1 in the
Z Grid Data, put it to 1.2.

3. To close the Define Grid Data form, click the OK button. Figure 33 will appear
after you click the OK button to close the Coordinate/Grid Systems box. As seen
in Fig. 33, the grids are displayed in two vertically tiled view windows: an X-Y
"Plan" View on the left and a 3-D View on the right. By choosing the Options

menu > Windows command, the quantity of view windows can be altered.

In Fig. 33, you will see that the "Plan" view is open. The title bar of the display is
highlighted when the window is open. By clicking anywhere in the view window, you

can make a view active. Keep in mind that Z positive is pointing "up" and that the
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Global Axes are also visible. When ETABS speaks about gravity's direction, it means

"down" or in the negative Z direction.

e Step 2 Clarify Material

A Define Materials *

Materials Click to:

STEEL

C2530 Modify/Show Material ..

A416Gr270

Cancel

Figure 34. ETABS Define Materials form

To create, change, or remove a material property definition, use the Define menu >
Materials command. The structural objects (frame sections, cable sections, tendon
sections, area sections, solid properties) are then defined using the definitions of the

material properties.

The Define Material form (Fig. 34) will appear when you select the Materials

command from the Define menu.

3 Waterial Property Dats % 3 Material Property Data X
General il Data General | Dat:
SR Material Name STEEL
Material Type: Matenal Type
Directional Symmetry Type
SRR RE Directional Symmetry Type e

Material Display Color

Materal Display Color
Material Notes WModiy/Show Notes

Material Notes Madify/Show Notes.
Material Weight and Mass
Material Weight and Mass

Weight per Unit Volume: 2447.32 kgf/m?

Mass per Unit Volume 2447.319 kg/m? Weight per Unit Volume 7833.41 kgf/m?
Mechanical Property Data Mass per Unit Volume 7833414 kg/m®

Modulus of Blasticity, E 3050.15 legf /mm?

Mechanical Property Data
Poisson’s Ratio. U

Modulus of Easticity. E kgf/mm?
Cosfficient cf Themal Expansion. A 0.0000088 e
Shear Moduius, G 127465 kgf/mm? s,
Coefficient of Themal Expansion A 17c
Design Property Data
Shear Moduius, G gf/mm?
Modfy/Show Matenal Property Design Data
Advance d Material Property Data Design Property Data
Noniinear Materal Data Material Damping Propertics Modfy./Show Material Property Design Data
Tme Dependent Propertiss
Advanced Materal Propety Data
Moduius of Rupture for Cracked Deflections Noniinear Material Data Material Damping Properties

Figure 36. ETABS Material
Property Data form -Rebar

Figure 35. ETABS Material
Property Data form -Concrete
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A 4000Psi should be highlighted in the Materials display list. Next, click the
Modify/Show Material option to bring up the form in Fig. 35.

A Type C20 in the Material Name and Display Colour edit boxes and choose concrete

from the drop-down list under Material Type.
A. Select 25 as the Weight per Unit Volume. Modulus of Elasticity at Set

B. Set Weight per unit Volume as 25. Set Modulus of Elasticity to
4351.1324

C. Set Poisson’s Ratio to 0.2. Set Specified Concrete compression
strength at 29000, then push the OK button.

D. Inthe Materials display list, select an A992fy50. The form shown in Fig. 34
will appear once you click the Modify/Show Material button.

E. Type "Rebar" in the "Material Name" and "Display Colour" edit boxes and

choose "Rebar" from the "Material Type" drop-down list.

F. Set 72.5189, 106.7783, 72.5189, and 108.7783 for the minimum yield
stress, fy, minimum tensile stress, fu, expected yield stress, fye, and
expected tensile stress, fue. To exit all forms, click the buttons on the

Material Property Data form and the Add materials form.
e Step 3 Define Frame Section

When a frame section is defined, it can be assigned to frame objects.

3 Frame Properties *x

Fitter Properties List Click to
Type Al ~

Properties

Find This Property Modify./Show Property

C45x45c30 16620

Export to XML File

C050.080.30

C055.40.30

€055.055.25

C055.055.30

C055.080.30

C060.35.30

C060.80.30 N

Figure 37. ETABS - Frame properties table
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You can define frame section properties based on a section's dimensions using

the Define menu > Frame Sections command,

import sections from preconfigured databases, review and amend section

properties,

and delete section properties.

Step 4 Establish Load Patterns

A.

B.

Define Load Patterns

Dead, Dead Wall, Dead Slab, Dead FF (Floor Finish), Dead RT (Roof
Treatment), Live, and Live Roof loads operating in the direction of gravity are

the loads used in this problem.

A. To open the Define Load Patterns form (Fig. 37), select the Define menu >
Load Patterns command. It should be noted that only one default load case—a
Dead Load scenario with self-weight [DEAD]—has been defined.

Keep in mind that the default case's self-weight multiplier is set to 1. This means
that the self-weight of all members will be automatically included in this load
pattern at 1.0 times. Both load patterns and load cases, which may vary, are
present | ETABS. However, when a load occurs, the application immediately

creates a corresponding Load case.
Select the Edit button next to the

Activate the Pattern Name column. Enter the new load pattern's name, DEAD
Wall. Choose a load type from the drop-down menu; in this instance, choose
SUPER DEAD. The Self Weight multiplier should be set to 0. To add the Dead
Wall load to the list of loads, click the Add New Load Pattern option.

. Add Dead Slab, Dead FF, and Dead RT load cases by repeating item B.

Enter the new load pattern’s name, LIVE. Choose the LIVE load type from the
drop-down menu. The Self Weight Multiplier should be set to 0. To add the Live
load to the load list, click the Add New Load Pattern option.
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[3 Define Load Patterns X

Loads Click To:
Self Weight Auto
Load Type Multiplier Lateral Load

LIVE Live 0
KONST Dead 0
NIND X Wind 0 EUROCCDE1 2005
uji Cther 0
lat X Seismic 0 EUROCODES 2004
lat ¥ Seismic 0 EUROCODES 2004

Cancel

Figure 38. ETABS Define load Patterns form

I. Enter the new load pattern's name, LIVE ROOF. From the drop-down list,
choose the type of load ROOF LIVE. The Self Weight Multiplier should be set
to 0. To add the Live load to the load list, click the Add New Load Pattern option

e Step 5 Define the Response Spectrum Function

A collection of time versus spectral-acceleration values is all that makes up a
response-spectrum function. Since the functions themselves are not assumed to have
units in ETABS, the acceleration values in the function are presumed to be normalized.
Instead, a scale factor that multiplies the function and is supplied when the response-

spectrum analysis scenario is constructed is linked to the units.

1. To view the Define Response Spectrum Function form, select the Define menu >

Functions > Response Spectrum Functions command.

2. From the drop-down selection in the "Choose the Function Type to Add" section,
select Spectrum from File.

3. The Response Spectrum Function Definition form (Fig. 38) will appear when you
click the Add New Function button.

4. In Function Nameatbox, type RES IS 1893 II.
5. In Function Damping Ratio area, type 0.05.

58



A EureCode 2 - 2004 Function Definition

Function Name
Parameters

Courtry
Direction

Ground Acceleration. ag/g
Spectrum Type

Ground Type

Soil Factor, 5

Spectrum Period, Tb
Spectrum Peried, Te
Spectrum Period, Td
Lawer Bound Factor, Beta

Behavior Factor, g

Convert to User Defined

Function Damping Ratio

[Ecare

Damping Ratio

CEN Default ~

Horizontal ~
1 ~
B ~

Function Graph

Function Poirts Plot Options
@ Linear X - Linear Y
O Linear % -Log ¥
O Log X - Linear ¥

O LogX-Log Y

Period Acceleration

OK Cancel

'
10.0

Figure 39. ETABS Define Response Spectrum Functions
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1. Select the text file containing the response spectrum data by clicking the Browse
button in the Function File section (see Appendix). The File Name display box will
show the path of the selected file. To view the selected file in WordPad, click the View
File button.

2. Type 5 in the Header lines to skip area.

3. Choose the Period vs Values option under the Values are: section.

4. To view the Response spectrum, click the Display graph button.

5. The Response Spectrum Definition form (Fig. 39) will appear when you click the

Convert to User Defined button.

6. To close all forms, click the OK buttons on the Define Response spectrum functions
and Response Spectrum Function Definitions forms.
e Step 6 Definition of Response Spectrum Load scenario

1. To open the Define Load Cases form, select the Define menu > Load Cases

option.

2. The Define Load case data form (Fig. 39) will appear when you click the Add
New Load Case button.

3. Enter EQ - X in the Load Case Name Area.

4. From the drop-down box in the Load Case Type Area, choose Response
Spectrum.

5. Choose the CQC option in the modal combination area.
6. Inthe area of applied load

7. . To accept the EQ- X analysis case, click OK on the Load Case Data - Response

Spectrum page.

8. On the Define Load Cases form, click the Add New Load Case button.

©

Enter EQ - Y in the Load Case Name field.
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10. Repetition of Items D-E

11. In Load Applied Area
e From the drop-down box in the Load Type field, choose Accel.
e From the drop-down list, choose U2 in the Load Name field.

e  From the drop-down list in the Function section, choose RS IS 1893 Il
(Function defined in step 7).
12. Select Add from the menu.

E Load Cases

Load Cases Click to:
Load Case Name Load Case Type Add New Case...
Modal Modal - Ritz Add Copy of Case...
DEAD I Modify/Show Case...
LIVE Linear Static Delete Case
KONST Linear Static A
EC8Bg=2.76 Response Spectum Show Load Case Tree...
EC8q1 Response Spectrum i
spec-v Response Spectrum
oK
Cancel

Figure 40. ETABS Define Response Spectrum Load case
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Figure 41. ETABS Undeformed shape of the building
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Figure 42. ETABS Deformed shape of the building after analyses
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CHAPTER 4

ANALYSES OF THE RESULTS

4.1 Technical specifications and loads

The Central Technical Archive of Structure (AQTN) office in Tirana has
taken the construction plan and technical specifications for the 82/2 building from the
technical archives. The Research and Design Institute No. 1 Tirana (ISP) created them.

This project’s design was for a structure with prefabricated reinforced concrete
frames. This building is intended for areas with a seismic intensity of IX, according to
the design notes. This project causes a delay in the beginning of the RC Frame

Structure's development.

The district's Research and Design Bureau (BSP) was tasked with
reconstructing the project in accordance with the technical project, considering the

geography, surrounding natural environment, climate, and tradition.

The Durres building typology 82/2 is being built in accordance with this BSP-
created design. Regarding this project's redesign, the following modifications have
been made to the structural project developed by ISP (Research and Design Institute,

Tirana): Assessment of Damages

Prior to 1990, Albanian Technical Codes KTP-2-89, which also incorporated
seismic design standards, served as the main reference for building designs. RC
frames, brick masonry (clay/silicate), and prefabricated constructions all had varying
degrees of failure during the Durres Earthquake.

e The main causes of RC frame damage:
Both structural and non-structural elements had visible damage.

o The construction of high-rise buildings with reinforced concrete frames rather

than diaphragms or cores to produce highly flexible structures. Non-structural
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components, such as out-of-plan walls and walls with horizontal and diagonal
fissures, have been found to be damaged.

o Differential settlement of the foundation brought on by seismic activity and
irregularities in plan and height.

O Using less structural stiffness, a structure can be designed with hidden beams
in slabs of lower height, particularly the perimeter beams.

O Improper stair beam design that results in "short columns" by lowering the
height of the columns.

o The lack of piles, even though they are required for seismic activity and the
transfer of vertical stresses.

o The seismic junction is inadequately designed when two pieces are built on the
same foundation slab or pile, which causes a collision.

o Because columns' strength is inferior to that of beams, plastic hinges have been
developed for them.

o Poorly constructed beam-column joints.

o The earthquake that occurred on November 26, 2019, caused two of the
analysed buildings (type 82/2) to collapse, while the other structures have

sustained major structural damage.

The following Figure from a field investigation shows damages to structural and non-
structural parts for various RC structures in Durres city.
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Table 3. Properties of steel C-3 at the type 82/2

Figure 43. Spalling of Figure 44. Figure 45.
concrete Longitudinal Out-of-plane wall failure
reinforcement

not fastened by stirrup

4.1 Materials' Qualities

Referencing the technical notes in the structural design of the type 82/2 structures

o Concrete is classified as M-200 (C 16//20).

o According to the KTP-Albania design code, the reinforcing steel is -3.
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Table 4. Properties of concrete for the building type 82/2

Characteristics of Reinforcing

steel (-3
Characteristic yield strength fyc =250 MPa
Characteristic tensile strength fue =320 MPa
Modulus of elasticity Es=210 000 MPa =210GPa
Partial factor Y¥s=1,15
Design yield strength fya =215 MPa
Design yield for shear Fywa = 180 MPa
Poisson's ratio v=0.30

Table 5. Concrete test for one of the building type 82/2

Characteristics of concrete C16/20 MPa
Characteristic compressive cylinder strength foe=20 MPa
Characteristic cubic strength Rex = 16 MPa (fck,cube)
Mean value of concrete cylinder compressive
strength (28 days) fom = 28 MPa
Mean value of axial tensile strength of concrete ferm = 2,2 MPa
Characteristic axial tensile strength of concrete fc(5%) = 1,5 MPa
Characteristic axial tensile strength of concrete fax(95%) = 2,9 MPa
Secant modulus of elasticity of concrete Em=30GPA
Design value of modulus of elasticity of
concrete Eca= 25GPa
Partial factor for concrete yc=15 «=0.85
Design value of concrete compressive strength fea = a*fex / ye= 11,3 MPa
Poisson's ratio v=0.20

Table 6. Real Steel tests for one of the building type 82/2

Lamping Dute / Dats @ marjes se mosires. 1729
Date of st 7 Data @ Proves 14
Loecaen Nurams stm / Oxawnatr! Nomina! | Mostrave @ = 141622 mm [ N R
Craven Noramat Daa / vum povitey
[ TEET RESULTS | REZULTATET & TESTIT
"‘ Tov | b = '3 - [‘. ',:. S S
| Y - S . -
- ' = Hapors Ul
- e O Db e Fasufors (w Hene s 4 S
o :-..‘ Tty [ Lineee) oo ertage ™ Kepute [Kopeqntitec] Mty Srarwre
: ‘c J A ne P ) ! revwres
frrvw | frrd J . % B jrer) [Praen” Memen | { RmiRe ) "
- 137 4021 1.50¢ 32.14
4.0! 175.40 333.€ 7.
Ly '.:g 1:“/ 78.27 :z,u,:)‘ 444 1314 -5.00
14
413 1.42
031 2 260.¢ 2%
“ 1.552 ! 160.4 400, 1.416 C
1 4 | 375.49 3 47 | 1.428 2.2
£ 1 376 1 469 1.415
|
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Source: Republic of Albania, VKM, "For the Implementation of In-Depth Expertise

for the objects damaged," Council of Ministers, Tirana, 2020

The results of the laboratory tests on the steel's qualities show that they are

acceptable considering the design definition and the technical situation.

We only discovered a small number of tests that are conducted, specifically

two tests for concrete and six for steel. in unnamed components

Laboratory tests and sample collection for analysis of concrete and steel. The
concrete sample's compressive strength is lower, per tests done in one of the 82/2
building types (for the item in Tables 4 and 5). Figures 43, 44 and 45 illustrate the KTP
(Albanian design code) criteria and less than 50% of the design requirements. While
the results of the laboratory tests on the steel show that they are acceptable given the
design specification and the technical requirements

4.2 Model and Examination

e The ETABS Ultimate 19 program is used to model the Type 82/2 structure in
two examples for the 6-story building. The project's technical notes are
followed when modelling the structure.

e Slabs serve as the shell pieces in a 3D frame section that makes up the
model.

e The material proprieties (concrete and steel) are taken as stated in section 5.
Dead, live, and seismic loads in accordance with KTP-6-78 (Albanian design
code) in the following ways:

e Slabs serve as shell elements in a 3D frame part of the object.

e The following loadings (dead, live, and earthquake) follow KTP-6-78
(Albanian design code): [13]
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Table 7. Test results

Coring Date / Dt. E Karrotazhit: 1212.2019
Testing date / Data o tostimit: 13.12.2019
IT:‘.'.'.':'.‘.'.'.‘.:.':'::;'.f;'::::.‘;'::.‘:::':::::::::':: R A IR F Xy o X
g Height || Diameter || H/ID ; Compr. %
il fortest | fortest | ratio |VOlONt JDensiy|l Load § grnom | Nt
Lartesia | Diametor
Pozicioni per test | per test Raport{| Masa || Masa [|[Ngarkesa§Rez. Shtypje| Shenime
H D HID fol Cubic
o) | (mm) § WO || fo) [igfem)] i) [MPa)
Eloment beton/arme marre nga mbetjote 5
objektit te siperpermendur te dopozituara 770 750 11.03) 778 2287} 27.9 8.32
pranc Rajonit te Pollcise Shijak
77.5 750 [ 1.03) 797 J2.328| 356 8.06
Sv=58g1 +0.825p1 + Sp2 (Equation 1)

Where:
g1 — dead load

p; — live loads
p, — live loads

Live loads are applied as follows:

Apartment p,, = 150 daN /cm?
Hallway p,, = 300 daN /cm?
Terraces p, = 200 daN /cm?
Response spectrum analysis and non-linear static analysis (Pushover), two
methods of analysis are carried out using the ETABS software [14]

To estimate how much reinforcement is needed to comply with this design
code, the structure is also simulated in accordance with design code guidelines. The
spectra captured at Durrés station during the earthquake on November 26, 2019, are
used to calculate the seismic loading. below
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Figure 46. Geometric model six storey

4.3 Results

The results of the two methods analysis, such as non-linear static analysis and
response spectrum analysis (Pushover), are displayed below. The interstorey drift is a
crucial factor to consider when estimating the damage caused by aspects both

structural and non-structural during earthquake activity

Floor
O =, NW

f

0 0.1 0.2 0.3 0.4 0.5
dr (%)
—@— X direction for 6 floors —@— Y direction fot 6 floors

Figure 47. Maximal drifts for the 82/2 type of building
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As shown in the Graphic in Figure 46 of the Maximum Drift, the 6-storey
building's interstorey drift can reach as high as 0.0043.

The criterion of EC-8 and KTP 89-2 are satisfied for the circumstances under
study (the maximum drift allowed by the code is 0.0087). Because there is less
reinforcing for the columns in the second through third floors, the inter storey drifts

are greater.

With reference to the columns on the ground floor are strengthened with 1 ¢
20+2 ¢ 16. The reduction is from 6 ¢ 20+2 ¢ 16 on the first floor to 4 ¢ 20+2 ¢ 16 in
the 2-nd floor (up to the top floor), which is a reduction of 27.4%. However, the

columns section's size remains constant.

Figure 48. Details for reinforcement of columns (as constructed)
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The six-story building exhibits a seismic capacity that is insufficient to meet
the seismic demand (for y-direction) according to the nonlinear static analysis

(Pushover)
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Figure 49. Capacity diagrams for 6-storey building X direction
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Figure 50. Capacity diagrams for 6-storey building Y direction
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The P-M2-M3 interaction determined from the response spectrum is represented by a

point outside the interaction curve (Figs. 50 and 51).

3D Interaction Surface Current Interaction Curve
E+3
2,80 -
240 -
2.00 -
1.60 -
Z 120-
=
o 0.80 -
0.40 -
0.00 -
040 -
-0.80 A 1 L} I I 1 1
-40 0 40 80 120 160 200
M (kN-m)
o |
Plan E deg [ Superimpose Dashed Fiber Curve
T
Hlevation iil deg Note: Compression is positive in this form.
-
o | [wm| [ews Done

Figure 51. Interaction curves for column in axes Al (specified in Fig. 47)

The ground floor and first floor columns' reduced ability to flex is evident from their

ends appeared to have plastic hinges and were in a ruined state.

It is demonstrated the predicted mechanism of hinges made possible by the invention

of plastic collapse develops on the first floor as opposed to the first floor (Figure 21).

E+3
2.80 -
2.40 —
2.00 -
1.60 —
= 1.20 -
~  0.80 -
0.40 —
0.00 -
0.40 —
-0.80 (| 1 1 (| | 1
-0 0 60 120 180 240 300
M (kN-m)

[

[C] Superimpose Dashed Fiber Curve

Note: Compression is positive in this form.

Done

Figure 52. Interaction curves for column in axes B2 (specified in Fig.6) of 6-storey

building
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Given the sudden altering the columns on this level's longitudinal reinforcement, this

is a plausible explanation.

The matching damage limit state is mentioned while describing the performance level.
A typical plastic hinge's force-deformation (moment-rotation) curve is shown in

Figure 52.

The first floor is where plastic hinges are produced; they correlate to points B (which
denotes yielding) and, in some cases, E (which represents complete failure). The first
floor of the six-story building also develops plastic hinges, some of which symbolize

the points C (ultimate capacity) and E.

N
|._&
B
g . cp
g 10 LS
= D E
=
\ >
Displacement

Figure 53. Force-Deformation relationship of a typical plastic hinge

The plastic hinge for the five-story building develops on the first level and
corresponds to points B (which denotes yielding), as shown in Figure 53 (the

distribution of plastic hinges) and E (which shows complete failure) in some elements.

The first floor of the six-story structure additionally has plastic hinges that

depict the points C (ultimate capacity) and E in some parts.
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Development of plastic hinges from the nonlinear static analysis (Pushover)
(mostly in states a few in the extremely plastic, rupture-prone D area, and the regions

A through B on the plastic hinge growth curve)

Figure 54. Development of plastic hinges with reference to Figure 53 (the

distribution of plastic hinges), for the six-story building

Since ground floor columns in reinforced concrete structures are the most
stressed components during seismic activity, a comparison of reinforcement according

to the project and structural modeling is done in this work

It is noted that the quantity of reinforcement needed (as assessed by response
spectrum analysis) exceeds the project's specifications, even for the six storey model.
The project's modeling in accordance with current design codes like Eurocode -8
reveals that these components (with the same precise divisions as those offered in the
design documentation) require extremely heightened defense, with respective values
of 5.88% and 6.96% (> 4%) that are disallowed by this code.
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Table 8. Ground-floor columns' reinforcing areas. Comparison of the two types of

ground-floor columns' reinforcing areas and percentages (as-built project vs. design

model).
6-storey
Reinforcement (cm2)
H Reinforcement (%)
As-build Design
project model
K-1 35.43 70.56
(2.95%) (5.88%)
K- 49.26 83.52
% (3.88%) (6.96%)

4.3 Conclusions of the specific analysis.

The goal of this study is to compare the findings from response spectrum
analysis (used to design potential reinforcements and assess the current project) and
non-linear static analysis (Pushover) in order to evaluate the Type 82/2's behaviour
and as well of the Type 88/2 - designed structure following the earthquake that struck
the city of Durres on November 26, 2019.

The following is a summary of the study's findings:

« Comparing the behaviour of our two buildings - and 6-story buildings reveals
that their collapse/failure mechanisms are identical.

* Plastic hinge development provides proof so rather than the ground floor, the
predicted collapse/failure mechanism occurs on the first floor.

» Rather than being tied to displacement and drift, the structural problems appear
Consequently, the projected collapse/failure mechanism happens on the first floor
rather than the first floor.

» The percentage of reinforcement needed for the given part of the 6-story buildings
is around 30% more than what is required by KTP and Eurocode 2 [15] while the
amount of reinforcement already present is only about 56% of what is called for

by design analysis. As a result, the concrete part cannot withstand loading.
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The increase in the ground floor columns' capacity ratio has had an impact on the
reduction in the sixth floor's bearing capacity, thus reducing the five-story
building's bearing capacity.

The first floor's reinforcement area for columns is down 35.5% from the ground
floor, while the second story's is down 27.4% from the first floor. This explains
why the second through third floor has large inter storey drifts.

This structure's poor performance during the Durres earthquake was caused by a
few flaws, which also resulted in damage to the buildings' load-bearing
components. This fact is made even clearer when considering the mistakes made
During construction, mistakes were made that were excused by the conditions and
construction standards in place during the years these structures were built (1983—
1993), such as the use of transversal reinforcement with a diameter and distance in
the seismic zone that does not meet design requirements, the use of smoothed rebar

as longitudinal reinforcement, or rather poor quality of the concrete used.
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CHAPTER 5

CONCLUSIONS

5.1 Conclusions

The September and November earthquakes were generated under the same
geological conditions. The energy partially discharged by the September 21
earthquake triggered the mainshock of November 26. The statical analysis of its

aftershock does not follow seismological law.

These earthquakes revealed and gave us a lesson on how important is to
identify in a short time damaged objects and declared uninhabitable objects, to save
lives and avoid injuries before another earthquake occurs. The best measure to be taken
in zones with high seismic activity is to build according to Eurocode, based on the best

seismic hazard map.
The extent of damage can be attributed to:

Existence of a large inventory of structures with deficient capacity and ductility
Location of the building: buildings in high seismic areas are more vulnerable.
Interventions during their lifespan

The area of construction (design code of the time, construction techniques)

Degradation of material: time, climate changes

o ok~ wbh

Poor workmanship-lack of qualified workers, volunteer collaboration

7. The abusive intervention in the building's structure design:
« At the VIP Building- the damage to the columns due to the poor material
properties
» At Barons Building- the damage to the beam of the foundation.
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e Response-Spectrum Analysis

To estimate the maximum seismic response of an elastic structure, response-
spectrum analysis (RSA), a linear-dynamic statistical analytic method, evaluates the

contribution from each natural mode of vibration.

By measuring pseudo-spectral acceleration, velocity, or displacement as a function
of structural period for a specific time history and damping level, response spectrum
analysis sheds light on dynamic behaviour. The peak response for each realization of
the structural period can be represented as a smooth curve by enclosing the response

spectrum.

Response-spectrum analysis links the choice of structural type to dynamic
performance, which is helpful for design decision-making. Longer structures undergo

greater displacement, and shorter structures have greater acceleration.

Prioritized design and response-spectrum analysis should consider structural
performance objectives. The various load situations shown in Figure 18 are applied to
the models. The results are created for both X and Y directions because the model's
plan is asymmetrical in both directions. Below is a list of the conclusions drawn from
several analyses, along with a discussion of them in terms of the Response Spectrum

analysis load case.

The outcomes of earthquake-resistant models are contrasted. The figures reveal
that VIP Building exhibits lower displacements while Baron Building exhibits higher
displacements. Storey displacement lowers by 40.24% in the F1 roof level and 18.17%
in the F2 roof level in the VIP building model.

e Base shear

It can be observed that VIP building model (SW) demonstrates a base shear value
of 5733 kN, which is higher than all other models. The lower base shear value for the
Baron building model (LRB) is 1531 kN.

This might be the case because, in model 1 (SW), the presence of a shear wall

causes the model's weight and base shear to increase.
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e Time Period

The time period vs model graphs for mode 1 (the first of five modes), according to
the Mode Eigen & Ritz load example. The graphs demonstrate that the time period of
the VIP model (SW) is reduced by 50.5%, indicating that the model is stiffer, while
the time period of the Baron model (LRB), which symbolizes flexibility, is raised by
52.4%.

Lower displacements, drifts, time period, acceleration (4.7%), and high base shear
(175%) are all characteristics of the Vip Model (SW), a shear wall model, which all
contribute to the model's viability as an earthquake-resistant model. Increased model
weight may lead to increased steel content, which indirectly raises the cost of the

construction.

Baron Model has high drifts, low displacements, and high. It does, however, have the
advantage of being able to offer wherever in the story that we need specifically, which
is not possible with other models.

The 2019 earthquake in Albania highlighted the vulnerability of many RC building
typologies. The most common design and/or construction deficiencies observed in RC

buildings after these earthquakes were:

1. Tlrregularities in height and/or plan of RC frame structure was often due to the
layout of masonry infills or stairs, which caused "soft storey"” failure mechanism
and/or torsional effects in these structures. The “soft storey” effect occurred due to
variation of stiffness in the building height, while torsional effects caused damage
of infills in RC frames located at the building perimeter. Therefore, it is important
to ensure a symmetric layout of infills in plan and regular distribution in elevation,

whenever possible.

2. Poorly detailed RC frame components for local ductility resulted in poor seismic
performance of Beam-column couplings, RC columns, and significantly

contributed to damage and collapse of RC frame structures.

3. Interaction of RC frames with masonry infills, which was not considered in the

design, sometimes resulted in a "short column” effect and failure of RC elements.
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Additionally, this interaction caused cracking of infill walls due to in-plane seismic
effects. It was observed that significant number of infills collapsed out-of-plane, which

can be assigned to the relationship between in-plane and out-of-plane seismic effects.

Buildings ought to plan and built in conformity with the current seismic design
standards and rules, as stated in point a. These codes outline the minimal

specifications for structural components, building materials, and construction.
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